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G E T T I N G  O R G A N I Z E D

This chapter covers a variety of programs designed to help
streamline your day-to-day tasks. Whether it is something as

simple as using the calculator on your computer (rather than sorting
through the drawer of stamps and rulers next to your desk) or some-

thing a little more complicated, such as merging your PDA’s address book
with your workstation, KDE can help make you more organized and efficient. 

KOrganizer

KOrganizer is a versatile program with organization options to meet many dif-
ferent needs. To open KOrganizer go to K menu • Applications • KOrganizer.
Newer versions of KOrganizer have groupware. This means that other people
will be able to view the same events on their calendars if that option is enabled
when you enter events and your network is properly configured. Talk to your
system administrator about enabling the groupware feature. 

KOrganizer has two basic features: the Events calendar and the To-Do list.
For those of you who might be a little forgetful, the calendar can create event
reminders that pop up on your desktop. If you like to plan ahead, the calendar
can be viewed daily, weekly, or monthly. Or if you have a lot of things that need
to be done as soon as possible, you can make use of the KOrganizer To-Do list. 
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When KOrganizer opens, you see your daily calendar, your To-Do list, and a
small monthly calendar.

Configuring KOrganizer

In KOrganizer, you can configure the preferences to view your business hours,
assign colors to different views, and have reminders pop up on your monitor a
few minutes before scheduled events. To access your preferences, select
Configure KOrganizer from the Settings menu. 

Figure 4.1: Opening KOrganizer

Figure 4.2: KOrganizer Preferences Window
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In the window that pops up, the seven configuration sections are listed with
icons on the left. Click any one of these to modify that section. Click Apply to
see your changes immediately; this is handy for testing the different colors and
fonts you might want to use. When you have finished setting your preferences,
click OK to save the changes, and exit the configuration window. If you do not
want to save your changes, click Cancel. To modify more than one section, go
from section to section by clicking the icons. 

T I P If you click Default in any one of these windows, all of your configuration settings will be
deleted and replaced with the default settings.

Personal Settings 
Personal is for setting the frequency of autosaves. You can also enter your email
address and choose Send copy to owner when mailing events if you want to
receive email reminders about events. 

Time & Date
Time & Date lets you specify your time zone, whether Saturdays and holidays
appear on the calendar, default business hours, and default appointment time.
When you open a daily or weekly view in KOrganizer, the default time at which
the calendar begins is the technical beginning of the day: 12:00 a.m. Here you
can set your default business hours to those that better suit your needs.
Likewise, the default appointment time is the time that appears automatically
whenever you enter a new event. Although it’s not necessary, setting a default
appointment time can be useful, particularly if there is a time that you generally
set aside for appointments. 

Figure 4.3: Personal Settings
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Fonts
The Fonts section is where you set the size and style of fonts used in
KOrganizer. Try a few different fonts to see what works best for you. 

Figure 4.4: Time & Date Settings

Figure 4.5: Font Settings

Colors
You can choose colors for different event categories, working hours, the back-
ground, and a few other items. By setting contrasting colors, you will be able to
differentiate items more easily when taking a quick glance at your calendar. 
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Views
Under Views, you can adjust the settings for each of the window types available
for viewing. To see your To-Do list in its entirety, you will probably need a full
window, so make sure that you have checked the To-Do View uses full window
option; otherwise, you may see only the first few items on your list. Similarly,
choose Month View uses full window to ensure that the monthly calendar
appears large enough on your monitor. You can also enable Show Marcus Bains
line, which inserts a red line with the current time of day into your daily calen-
dar, so you know how close you are to any given appointment.

Figure 4.6: Configuring KOrganizer’s Color Scheme 

Figure 4.7: View Settings
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Printing Settings
Here you select the program that previews a file you want to print. You should
probably use the default (kghostview) as your preview program, but gv and xv
both work well if they are available to you. 

Group Settings
This section is where you configure the email settings to use KOrganizer in a
shared environment. Add all of your group’s email addresses here, and check
with your system administrator when enabling this feature. 

Figure 4.8: Printer Preferences

Figure 4.9: Group Settings
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T I P The Settings menu also allows you to enable or disable the various toolbars and menus,
configure shortcuts (or keybindings), and change date and time settings.

Menus and Toolbars 

You are probably familiar with the options available in the menubar across the
top of the window. The more frequently used items in these menus are also
available on the Main toolbar, below the pull-down menus. As you become
familiar with the icons for each action that appear next to the option on the
menus, you will find that toolbars are time-savers. 

Toolbar Icons
There are two toolbars available in KOrganizer. To view these, you will need to
make sure they have been selected in the Settings menu. (They will have a check
mark next to them if they are turned on.) The two toolbars are the Main toolbar
(on top) and the Views toolbar.

On the Main toolbar, you will find icons for some of the most frequently
used actions.

• Blank page: creates a new file.

• File folder: opens a file.

• Disk: saves.

• Printer: prints.

• Printer with lightening bolt: opens the Print Preview window.

• Scissors: cuts.

• Two pages of text: copies.

• Page with a clipboard: pastes.

• Magnifying glass: finds.

• Backward arrow: goes back a day.

• Forward arrow: goes forward a day.

• Calendar with one day filled in: goes to today.

• Flying envelope: sends email.

• Calendar with star on it: adds a new event.

• Calendar with a check mark on it: edits your To-Do List.

T I P You should use only one file in KOrganizer. Using more than one file is as dangerous as
keeping multiple appointment books and is never a good idea.

Figure 4.10: The Main and View Toolbars
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The icons in the Views toolbar are:

• Paper with two red dots: lists what’s next (of your scheduled events).

• Paper with two items listed: lists events.

• Calendar with one day filled in: shows today.

• Calendar with five days filled in: shows the workweek.

• Calendar with seven days filled in: shows the full week.

• Calendar with all days filled in: shows a month.

• Calendar with a check mark: shows To-Do list.

Printing from KOrganizer

Clicking on the printer icon allows you to select the date range and the type of
view you want to print (Day, Week, Month, or a To-Do list). To select dates for
the date range, you can type in the date or click the calendar icon next to the
Date field, and then click the date on the calendar. 

Clicking on the printer with the lightning bolt gives you a chance to view a
file before it is printed. Then, you can make changes to the file before printing.
After you select this option, you go through steps as if you were printing the
file, but the end result will be a graphic file, which opens in the graphics pro-
gram that you selected in the Printing configuration options.

Using the To-Do List

With the To-Do list feature, you can create a list of tasks with subtasks, due
dates, and priorities, and then check off each item as you finish it. 

T I P When working with your To-Do list, you may find it easier to view it on its own; click
the To-Do List View icon to change your view.

Figure 4.11: Printing from KOrganizer
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Adding a Task to the To-Do List
To add a new item to your list, select New To-Do from the Actions menu. Enter
your task information in the General and Attendees tabs in the window that opens.

The only required field in the General tab is Summary, but you may find it
helpful to enter some additional information about the item, such as due dates
and times.

Enter the name or a brief description of the task in the Summary box. This
name will be visible on the left edge of the To-Do list box and will have a check
mark next to it. To select a due date, make sure the box next to Due is checked,
and then select a due date from the calendar or type the date in the text field. If
you want to have a due time, check the box next to Time associated, and you’ll be
able to enter a time in that field. If you want to have a start date also (or instead),
follow the same procedure with Start that you used for setting a due date. 

Use the pull-down menu on the right to set the priority of the task. The
default priority level is 3 (medium). You can also select a percentage completed
from the pull-down menu on the left to keep track of your progress. 

Enter any notes or comments about the task in the large text field toward
the bottom of the window. You will be able to view these notes by double-
clicking the to-do item after it has been added to your To-Do list. 

To enter a category for the task, click Categories, and a new window will
appear showing the various categories. 

Figure 4.12: Creating a New To-Do Item
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To add a category that doesn’t appear on the list, click the Edit Categories
button, and an Edit Categories window will appear.

Figure 4.13: Categories List

Enter a name for the new category in the blank field toward the bottom of
the window, and click Add. To remove a category, highlight the category and
click Remove. Click OK to save your changes. 

If you have groupware capability and you want the same task to appear on
the list of everyone in your group, select Public from the Access menu in the
Edit To-Do window. Otherwise, select Private or Confidential. 

Attendees
None of the information in the Attendees tab is required, although you might
find it useful if you manage large projects with a number of participants. Click
New to add a new name and email address. You can choose a Role, such as par-
ticipant or observer, and a Status, such as Needs Action or Declined, from the
pull-down menus. The Roles and Status menus cannot be edited. 

Figure 4.14: Edit Categories
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After you have finished entering the information on the attendee, choose
Apply to add the attendee to the list. All event attendees will appear in the main
window of the Attendees screen, and their details will be listed under the corre-
sponding sections: Name, Email, Role, Status, and RSVP. After an attendee has
been added to the list, you can edit the attendee information by highlighting it,
making your changes, and selecting Apply. You can remove an attendee by high-
lighting it and selecting remove. 

Viewing and Editing Your To-Do List
Once an item appears on your To-Do list, you can view its details or edit it by
right-clicking on the item. A pop-up window will appear with the following
options: 

• Show: a small window pops up that includes all of the information you have
entered about the item. As a shortcut to this option, double-click the item. 

• Edit: displays the window in which you originally entered the item (with
General and Attendee tabs), allowing you to make changes.

• Delete: pops up a warning that asks if you want to delete the item
permanently. 

• New To-Do: adds a new item to your list. 

• New Sub-To-Do: adds subsidiary to-do items. This option is not available
from any other menu. 

When you select New Sub-To-Do, you will go through the steps of creating a
new item; however, the item will be listed under the To-Do task that was
selected. Each task on the list with sub-to-do items will have either a - or a +
next to it. If there is a -, all of the sub-to-do items are being shown, and if
there is a +, all of the sub-to-do items are hidden. You can switch back and
forth between the two views by clicking the - or +. 

• Purge Completed: next to each of the items on your To-Do list is a small
black box. If you are using this list to keep track of current projects, you
may want to check off each item as it is completed. Purge Completed
deletes all the items you have checked off.  

T I P Items can be moved easily among To-Do lists using the drag-and-drop method.

To-do items and sub-to-do items can be sorted in a few different ways. Click
Summary to sort alphabetically or Priority to sort from highest priority to the
lowest. Due Date and Due Time both sort chronologically, although items with-
out a due date will appear first on the list if you sort by Due Date and last on
the list if you sort by Due Time. 
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Scheduling Events

When viewing the calendar, you can move from day to day by clicking the day in
the monthly calendar (the small monthly calendar on the left side of the win-
dow) or by using the arrows at the top of the monthly calendar. The single
arrow is for months; the double arrow is for years. 

If you are on one of the Week views and click a single date from the
monthly calendar, you will be shown the Daily view for that particular day. 

Adding an Event
To add an event, double-click in the calendar window. The pop-up window that
appears has the same tabs as the one for the To-Do list, with an additional
Recurrence tab. So, the process of creating a new event should be familiar. 

Figure 4.15: Sorting Your To-Do List

Fill in the Summary field and the Start and End dates and times. Once the
times are entered, the duration of the event will be shown to the right of these
fields. If a default time was specified in the configuration settings, it will show
up automatically. If there is no time frame associated with the event (only
dates), then check the No time associated box. The event will appear as lasting
one full day if you select this option. If the event will occur on a regular basis,
check the Recurring event box. Then you can enter more information about the

Figure 4.16: Adding an Event
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repeating event on the Recurrence tab (see the “Recurrence” section for more
on this option). 

To receive a reminder, check this box. If it is checked, you can enter the
number of minutes, hours, or days before the event for which you want to
receive a reminder. To do this, enter the number in the text field; then select
minutes, hours, or days from the pull-down menu. You can also choose to have
an audio or video file as a reminder for an event. Click the music note or
running-man buttons next to the pull-down Time Increment menu to select
either of these options. After you click the audio or video button, a window
pops up where you can choose one of the audio or video files that comes with
KDE, or you can select your own file. 

T I P To use the alarm function, you need to choose Make Active from the File menu before
exiting the program. This option keeps track of appointments, even while KOrganizer is
not open, and sends you reminders.

With the Show Time As menu, you can select either Busy or Free. This
option shows the time period in the calendar as being either busy or free. 

The Categories window here is the same as the Category window that
appears when you create a new To-Do list item, and it can be edited in the same
manner. 

T I P The content of the category lists for both To-Do items and events is the same. When you
edit one list, you actually edit both of them.

Again, enter any notes or comments in the large text field. You will be able
to view these notes by double-clicking the event after it has been added to your
calendar. 

Also, if you have groupware, select Public to have the event show up in the
calendar of everyone in your group. Otherwise, select Private or Confidential. 

The fields on the Attendees tab are identical to those in the Attendees sec-
tion of the To-Do list (see the “Using the To-Do List” section). 

T I P Mail appointment is available from the Action menu only when an event on the
calendar is selected and attendees have been entered for the event with email addresses.
When you select this option, an email message with the event summary, start date, time,
and end time is generated automatically and sent to the attendees.

Recurrence
The third tab of the Edit Event window, Recurrence, is completely unique to the
Event calendar. If you have not checked the Recurring event box in the General
window, you will receive the following message: “This event does not recur.
Enable Recurrence in General Tab.” After you have enabled Recurrence, you
will be able to make the event appear in the calendar on all of the dates when it
occurs. The event must happen on a regular basis for you to be able to use this
option, for example, a meeting held the first Tuesday of every month. 
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The Appointment Time set in the General tab is used here. If you want to
change it, you need to go back to the General tab. In the Recurrence Rule sec-
tion, click the correct button for the frequency with which the event recurs.
Then, fill in the correct information for that option. In the Recurrence Range
section, you can choose No Ending Date for the event (it will continue on for-
ever); you can enter the number of times you want the event to recur; or you can
select the date on which the event ends. In the Exceptions section, you can add
an exception by choosing a date from the calendar and clicking Add. To remove
a date, select the date in the large box next to the event and click Delete. 

T I P Show Filter, available from the Settings menu, provides the following options: Filter
Enabled, Include: Recurring and Floating, and Exclude: Recurring and Floating. These
let you select whether you want to see both recurring and one-time events, or whether you
want to exclude these from your view. Select Filter Enabled to activate the filter. If you do
not select any of these options, both floating and recurring events are included in the view.

Viewing and Editing Events in Your Calendar
Edit events the same way you edit the To-Do list. Right-click on an event, and a
menu appears with the following options: 

• Show: displays the information about that event.

• Edit: displays the window in which you originally entered the information,
allowing you to make changes.

• Delete: asks if you are sure you want to delete a particular event.

• Toggle Alarm: if the alarm/reminder is turned on, a small bell symbol
appears next to the event. Click Toggle Alarm to turn the alarm on or off.

Figure 4.17: Recurring Events
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T I P You can also use your mouse to edit some event properties from any calendar view. To
change an event time or duration, simply drag and drop the event to the new date or
time. To change the duration of the event, position your mouse over the top or bottom
edge of the event, and a double vertical arrow will appear. Press the left mouse button
and stretch (or shorten) the event time by moving the mouse. Release the button when
you are finished.

In the Daily, Workweek, and Week calendar views, a status bar appears
above the main calendar with a summary of events. You can edit an event by
right-clicking it in this window, as well as in the main calendar window. 

Importing, Exporting, and Archiving in KOrganizer

Available from the File menu, these options make it simple to access calendars
from other programs and archive appointments with KOrganizer. 

Importing
Import from Ical allows you to import files saved in iCalendar format. The only
requirement for this is they must have the correct file extension, .ics. 

Merge Calendar is the equivalent of importing a calendar. You can import
files from other programs rather than entering the information all over again.
To merge calendars, first make sure you are in the calendar to which you want
to import the information (whether it is a new file or one that you have been
using already, and then select the file to be imported in the Location box. 

Archiving
Archive Old Entries allows you to store appointments that have passed but that
you don’t want to forget. To do this, select the start date (the date from which
you want the archiving to begin) and a filename. 

Exporting
The three options available here are Web Page, iCalendar, and vCalendar. When
you export a file, it is saved as a new file rewritten in whichever format you have
selected. 

T I P After you have exported a file, your best option for making changes is to update your
KOrganizer file and export the file again.

When you select Web Page, you can choose to export the To-Do list, the
Events list, or both, for viewing in a web browser. At this time, you can also

Figure 4.18: Archiving Appointments
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choose the dates from which you want information to be exported. In the Event
section, you can choose to include Categories and Attendees. In the To-Do List
section, you can choose to include Due Dates, Categories, and Attendees. After
you have finished selecting the features you want exported, click Export. 

T I P Use your browser to open your exported files by typing the filename in the URL field.

Note that the Events calendar, while not very detailed, is in an easy-to-read
list format. The To-Do list shows the full description of each item and has links to
Sub-To-Do Items (shown below the full list of To-Do items). If you choose to
export either of these separately, your file will include only that section. 

The two other exporting options, iCalendar and vCalendar, are more
advanced options that can be used in conjunction with KPilot. vCalendar is a
file format that stores information in ASCII format, which is easily imported to
other organization programs. iCalendar is a file format that allows calendars to
be shared over the Internet and is compatible with PDAs. 

KPilot

KPilot is an application that allows you to transfer information between your
desktop computer and a PalmOS-based (version 3.3 or higher) PDA. The pro-
gram is compatible with a number of PDAs, although some of the options avail-
able for each will be slightly different. A docking station is required, but these
are packaged with most handheld devices available today. To open KPilot go to
K menu • Utilities • KPilot. 

You will only be able to transfer files from KPilot to your PDA, and vice
versa. This means that, unless you have files loaded in KPilot, they will not trans-
fer to your PDA, and files from your PDA will be accessible only in KPilot. This
limits your options, but additional software is available for free download from

Figure 4.19: To-Do List and Events Exported to a Web Page 
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several sites. You may be able to find programs that enable calendar sharing,
and so on. Try searching http://www.tucows.com to find more information
about these options. 

Syncing with KPilot

To begin transferring data from your PDA to KPilot, simply set your PDA in the
docking station. Then choose Hot-Sync or Fast-Sync from the File menu, or
click the Hot-Sync icon on the toolbar. You will be prompted to press the Hot-
Sync button on the docking station, and the connection between computer and
PDA will be opened. 

While using KPilot, you will be prompted to take action by a small line of
text at the bottom of the window, which can be easy to miss. KPilot does not
give thorough information on its status or the syncing status, but your PDA
probably will. 

KPilot Files

The standard file types that KPilot syncs and allows you to open (from KPilot)
are Memos, Address Book, and File Installer. These can be opened from the
Conduits menu or the pull-down menu on the right side of the toolbar.
Choosing KPilot v4.x.x will return you to the main screen of the application. 

Address Book
The KPilot Address Book is easy to use and completely compatible with your
PDA. Use the menubar in the top right corner of the KPilot window to open
any of your files. 

Figure 4.20: The KPilot Address Book
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Memos
Memos are great because you can import small text files from your computer
into KPilot and then sync these to your PDA, and vice versa. This option opens
the memos file that includes memos from your PDA. In the window that opens,
you can import text files from your computer into KPilot, export memos to your
computer, delete memos, edit memos, or view memos. By using the pull-down
menu at the top of the window, you can view the different memo categories.
These reflect the categories you have set in your PDA. You will not be able to
edit these categories in KPilot; you must edit them in your PDA. Then the next
time you sync, the changes will be reflected in KPilot. To view a file, highlight it,
and the text will appear in the column on the right. 

T I P Once you have imported a text file into the Memos section of KPilot, you will not be able
to delete the item until after you have synced and transferred the file to your PDA.

File Installer
As you become a skilled user, you may to want to change the external conduits.
For external conduits, you will have the option of adding new functionality and
files to your PDA through the File Installer, although the exact options will
depend on the type of PDA you are using. To import your KOrganizer To-Do
list into KPilot, choose Conduits • External. From here, you can click
KOrganizer To-Do Conduit, and then drag and drop this item from Available to
Active. Double-click it to view the options, and choose the appropriate file from
which to import the data. It must have the .vcs extension. iCalendar is a file for-
mat that allows calendars to be shared over the Internet and is also compatible
with PDAs. If you use a Microsoft Windows PC or Macintosh, you will need to
purchase a version of iCalendar to make the iCalendar files on your PDA acces-
sible from that computer. However, KOrganizer has the ability to import and
export iCalendar files. 

Figure 4.21: Importing Text to Your PDA
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T I P To import your KOrganizer To-Do list, you must save it in vCalendar format so it can be
read by your PDA.

Configuring KPilot

The configuration options available for KPilot are somewhat different from
those of other programs and are much more technical. The only sections you
need to know about, in all likelihood, are General and Sync. To change the con-
figuration options in KPilot, choose Settings from the File menu. 

T I P There is no default button in this configuration. After you change the options and click
OK, you will not be able to change them back to the defaults without manually setting
them yourself. You can cancel your changes in a session by clicking Cancel at any time. 

In the General section, you will need to specify the following: 

• Pilot Device: the name of the serial port to which the PDA cradle is linked
on your CPU. The default is /dev/pilot, which will probably work for you.
You shouldn’t change from the default, unless you attempt to sync and the
process does not work. 

• Speed: lets you change the speed at which the transfers occur by using the
pull-down menu next to Speed. This setting depends solely on the model of
PDA you use, so you may want to try a few different speeds to see which
works best.

• Pilot User: enter the name on your PDA, which will be checked against your
login name. If these do not match, you will be asked which one is correct,
and this name will be used as the Pilot User name. 

T I P Newer PDAs can transfer at much faster speeds than older PDAs.

There are four startup options, and you can choose to make active as many
as you want. You should probably get a better feel for KPilot before choosing
any of these options, though. Here is a brief description of each. 

Figure 4.22: KPilot Settings
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• Start Hot-Sync Daemon at Login: automatically begins a Hot-Sync operation
as soon as you log in.

• Start KPilot at Hot-Sync: lets you begin a Hot-Sync operation even when
KPilot is not open, although the application will be started as soon as you
click the Hot-Sync button.

• Show Daemon in KPanel: displays the Hot-Sync option in your panel,
although it is available only to some users.

• Stop Daemon on Exit: stops the syncing process when you exit KPilot.

T I P A daemon is a computer process that makes something happen. In KPilot, it is basically
the syncing process. 

The Address section can be left with its default settings, but here’s a brief
description:

• Address Formats: the Import and Export formats both specify the order in
which information (name, address, city, state, and so on) is transferred when
syncing. Each field is represented by three characters: two letters and a %.

• Address Display: when you view a list of records, this option allows you to
list them either by last name and then first name, or by company name and
then last name. 

The DB Specials options are for configuring the databases. The defaults
here should be fine.

• Show Secrets: any records marked as Private in your PDA will not appear
when transferred to KPilot.

• Backup Only: items in this list indicate the databases that will be backed up
when you sync.

• Skip: skips this database when syncing.

• AvGo: the abbreviation for AvantGo, a database for news articles that you
may have on your PDA. The AvGo database is listed by default for the Skip
option.

The last section, Sync, includes some extra options. You may want to
explore these further after you become a syncing pro. 

• Sync Files: select this if you want files in the File Installer to be installed on
your PDA in the next sync.

• Local Overrides Pilot: assumes that the files on your PDA are more recent
than those in KPilot and replaces the KPilot files with the PDA files.

• Force First-Time Sync Every Time: select this if you are using more than
one PDA with KPilot.

• Do Full Backup When Changing PCs: select this if you are using more than
one PC with your PDA. 

• Prefer Fast-Sync to Hot-Sync: Fast-Sync does not perform a complete sync.
You probably shouldn’t choose this item.

6594 LITW Chapter 4  9/12/02  4:08 PM  Page 64



Getting Organized 65

KArm: Time Management

If you track your time for billing purposes or even if you are curious about
where your time goes, KArm is a handy feature. To open KArm, go to K menu
• Utilities • KArm.

Working with Tasks

The first time you use the time tracker, you will need to create a new task. In
the future, you will be able to either select an old task or create a new one. To
create a new task, click the blank-page icon on the toolbar. You can create as
many tasks as you like. 

Figure 4.23: Opening KArm

Next you are prompted to enter the task name and given the option to Edit
Absolute or Edit Relative. For a new task, click the button next to Edit Relative,
and make sure the + sign is selected. You don’t need to enter anything in the
blank field next to it. 

Figure 4.24: Creating a New Task in KArm
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T I P When adjusting times, note that the first field is for hours and the second is for minutes.

To begin using the time tracker, first make sure that the appropriate task is
highlighted (single-click on it), and then click the start icon. To stop, highlight
the task and click the stop icon. After you have started the clock, a small clock
will appear next to the item, and the hand on the clock will go in circles. After
you have stopped a task, the clock will disappear. 

T I P To run the clock for more than one task at the same time, simply follow the instructions
for starting the clock on each task.

T I P As a shortcut for starting or stopping the clock on a task, simply double-click the task
with the left mouse button.

To create a subtask, first choose the item for which you want to create the
subtask, and then click the subtask icon and follow the instructions for creating
a new task. Tasks with subtasks will have + or - next to them in the list of tasks in
the main window. If all of the subtasks are listed, a - will appear next to the task.
A + will appear if the subtasks are hidden. Click the + to make the subtasks show
up and the - to hide the subtasks. 

T I P When you delete a task, any subtasks are also deleted.

The list can be sorted in different ways by clicking the column headings for
each option. Task Name sorts the list alphabetically; Session Time sorts from
shortest to longest session time; and Total Time sorts from shortest to longest
total time. 

The status bar in the lower right corner keeps track of the total time that
has elapsed while tasks were active. When you have finished using KArm, you
can select Quit, and your changes will be saved automatically. 

If you need to adjust the times on a task, highlight the task and click the
Edit icon. If you want to add (or subtract) time from both the session time and
the total time, choose Edit Relative. Select either + or - from the pull-down
menu, and then enter the number of minutes you want added or subtracted in
the blank text field. To adjust the session time and total time separately, click
Edit Absolute and make adjustments to the session time and total time as they
appear in the fields. 

Configuring KArm

To configure KArm, select Configure KArm from the Settings menu. From
here, you can set the Idle Detection and Saving preferences. For those of you
who often leave your computer unattended, the Idle Detection definitely will
come in handy. To set Idle Detection, check the box next to Try to Detect
Idleness, and then choose the number of minutes to elapse before you will be
informed that your computer is idle. If your computer senses you have not been
using it for the selected number of minutes, a window will appear, and you will
be given three options: Revert and Stop, Revert and Continue, or Continue.
Simply click the appropriate button. 
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KNotes

Also known as Popup Notes, KNotes is the equivalent of having Post- it notes on
your desktop—but you don’t have to tape them to your monitor to make sure
they stick. If you tend to ignore your lengthy To-Do lists, KNotes are a great way
to keep track of life-or-death matters you may otherwise forget. 

T I P The default color for KNotes is a horrendously bright yellow, and although this can be
changed, it is probably a good idea to change it to an equally blinding color, so the notes
do not go unnoticed.

To open KNotes, go to K menu • Utilities • KNotes. This application seems
almost invisible. After you open KNotes, a small icon will appear on the K panel
that looks like a pen writing on a small yellow notepad. If you had KNotes open
when you quit a previous session, it will open automatically on the startup of
another session. 

Figure 4.25: A KNote

To access the main KNotes menu, simply right-click on the KNotes icon in
the taskbar on your desktop. The main menu lets you open new notes, quit, and
so on. 

A separate menu is also available for each note. Right-click on the title or
name of an open note. The menu options for individual notes include Insert
Date, Mail, Print, Note Preferences, Always on Top, and so forth. The To
Desktop option even lets you move notes between virtual desktops. 

Figure 4.26: The KNotes Icon
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T I P Choose Always on Top to ensure you don’t “lose” a note on your desktop.

Working with KNotes

To open a new note, right-click the KNotes icon, and then choose New Note
from the menu. A note will appear, and you can click it and begin entering text.
To end, simply click elsewhere on the screen. 

T I P To open an older note, left-click on the KNotes icon and choose a note from the menu.

The next time you open KNotes, any notes still active (notes that have text
in them) will open automatically, and you also will have the option to open a
new note. To close a note, click the X in the upper right corner of the note. 

Configuring KNotes

To set the preferences for KNotes, right-click on the small notepad icon and
choose Preferences. You will be given options to change the Display, Editor, and
Action settings. If you set the preferences from this menu, these settings will
remain for any new note you open. You also can set the configurations for each
individual note from the individual note menu mentioned earlier. 

In the Display and Editor settings, you can set the color of text in your notes,
the background color, note width and height, font size, tab size, and so on. 

KNotes can open an email program and insert the text from a note into the
body of an email message. You must specify the email program you want to use
in the Actions section of the configuration menu. Ask your system administrator
to set this up for you. The default is KMail, but other email programs will work
as well. 

Figure 4.27: Configuring KNotes
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KJots

KJots is roughly the equivalent of KNotes with a thorough filing system. In this
program, the user creates books and uses the pages within the books to write
notes. One advantage of this program is that the books, and the pages within
the books, can be saved in ASCII format. KJots could be a handy way to organ-
ize your notes for several different projects. To open KJots, go to K menu •
Utilities • KJots. 

Using KJots

To begin using KJots, you must first enter the title of the book you want to cre-
ate by choosing New Book from the File menu. A dialog box will open, asking
you to enter a name for the book. The title then appears in the bottom left cor-
ner of the KJots window, and you can type your notes into the text field. If you
want to add a page to your book at any point, simply click the blank-page icon in
the toolbar or choose New Page from the Edit menu on the toolbar. 

Books that you use frequently can be added to the Hotlist by choosing
Hotlist from the menubar and selecting Add Current Book. All books on the
Hotlist may be accessed easily by buttons. 

KCalc

KCalc is KDE’s easy-to-use calculator utility. To open KCalc, go to K menu •
Utilities • KCalc. When you open KCalc, a window pops up that looks like an
ordinary calculator. You may find this application useful because the calculator
includes some options that are not available on the standard ten-key calculators
used in many offices. 

Figure 4.28: KJots
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Using KCalc

To perform an operation, simply use your mouse to click the appropriate but-
tons, as with a handheld calculator. You can also enter numbers by using your
keyboard and pressing ENTER instead of the equal sign, but to perform most
functions, you must click the keys on the calculator. 

Configuring KCalc

To change the preferences for KCalc, click the Configure button toward the top
of the window. The Precision settings control the libc and libmath files on your
computer. It is best to leave both of these at the default values, which should be
adequate for normal use. 

Mode changes the functions of the buttons in the left-most column on the
calculator. You may need to change the mode between Trigonometry and
Statistical, depending on the kind of work you’re doing. You can also customize
the fonts and colors of KCalc from here.  

Figure 4.29: KCalculator 
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